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1 Overview  

This document describes the process of training a classifier using the Caffe deep learning framework 
and a set of images to produce a classifier contained within a binary file. 

Setup time normally takes a few hours but is dependent on access to a GPU. It also depends on the size 
of training sets, number of iterations, size of intervals, and number of layers used during the training 
process. 

 IMPORTANT: To become familiar with the process, read this entire document before following the 
steps required to build and train a classifier. 

1.1 Additional Support Documentation  

Additional Engineering Application Notes (EANs) can be found on the Documentation page of the 
SightLine Applications website.  

The Panel Plus User Guide provides a complete overview of settings and dialog windows. It can be 
accessed from the Help menu of the Panel Plus application. 

The Interface Command and Control (IDD) describes the native communications protocol used by the 
SightLine Applications product line. The IDD is also available as a PDF download on the Software 
Downloads page. 

1.2 SightLine Software Requirements   

Building a custom classifier requires a 4000-OEM, 3000-OEM, or SLA-Library running version 3.2.xx 
software or later. Caffe software is based on working in a development environment using a PC 
running Windows 10. 

 IMPORTANT: Starting with 3.6.x software and above, only the 4000 and 1700 platforms will be 
supported. The 1500 and 3000 platforms will continue to be supported in 3.5.x software. Some 
features in 3.6.x and above may not be available on 1500 and 3000 platforms. 

1.3 Application Bit Requirements    

The functions described in this EAN require Application Bits (app bits) purchased from SightLine. App 
bits are enabled with a license file provided by SightLine at initial unit purchase or during a license 
upgrade process. License files use a hardware ID that is applicable to a specific hardware serial 
number. For questions and upgrade support contact Sales. 

Table 1: Application Bits Requirement Table  

Function Initial Software Release Required Application Bit(s) v7 License 

Custom Classifier 3.2.x Custom Classifier 0x0100 0000 

Requires either/or:  

Track 0x0000 0010 

Detection 0x0000 0008 

Det Adv 0x0000 0028 

 

https://caffe.berkeleyvision.org/
https://sightlineapplications.com/documentation/
https://sightlineapplications.com/downloads/
https://sightlineapplications.com/releases/IDD/current/
https://sightlineapplications.com/downloads/
https://sightlineapplications.com/downloads/
mailto:sales@sightlineapplications.com
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1.4 Classifier Knowledge Recommendation    

This EAN provides instructions for custom classifier development that allows customers to deploy 
custom classifiers on SightLine hardware.  

 IMPORTANT: While these scripts are simple to run by following the steps outlined in this 
document, SightLine recommends familiarity with the machine learning concepts outlined here 
before continuing with custom classifier development. 

Machine learning concepts: 

• Key components of a robust dataset (to be used for training, testing, and validation) 

• Training vs. testing 

• Supervised learning and classification 

• Overfitting and underfitting 

• Layers and tunable parameters that make up a typical Convolutional Neural Network (CNN). 

• Epochs and tuning the number of them 

• Confusion matrices 

• Accuracy vs. confidence 

• Balancing bias and variance 

• Basic data analysis techniques 

2 Third Party Software 

 IMPORTANT: Python 3.5 is required for software version 3.3.x. Python 2 and other versions of 
Python 3 are not supported. 

 If Python 2.7 is needed, the samples for software version 3.2.x can be used.  

2.1 Python 3.5 Installation  

Required starting with SightLine firmware version 3.3.x software.   

1. Download Python 3.5 from the Anaconda website.  

2. Install the software to C:\Anaconda3\.  

 IMPORTANT: During the installation, All Users defaults to the destination folder of C:\Anaconda3\ 
shown in Figure 1. The remainder of this document assumes that the Python software is installed to 
this location. 

https://repo.anaconda.com/archive/Anaconda3-2.4.1-Windows-x86_64.exe
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Figure 1: Python Installation Default Location 

3. Accept all defaults. 

 

4. Open an Anaconda Prompt as administrator and run:  

conda install protobuf 

 Installing protobuf may upgrade Python version to 3.5.4, this is expected. 

 IMPORTANT: If Python 3.5 was installed in a conda environment, instead of from the initial 
download described in Python 3.5 Installation, it is important that the conda environment is active 
before continuing further.  

2.1.1 Python 2.7 [Legacy]  

Python version 2.7 is required for version 3.2.x software. Do not use any other versions of Python 
software. 

1. Download Python 2.7 from the Anaconda website.  

2. Install the software to C:\ProgramData\Anaconda2\.  

 IMPORTANT: During the installation, All Users defaults to the destination folder of 
C:\ProgramData\Anaconda2\ shown in Figure 2. The remainder of this document assumes that the 
Python software is installed to this location. 

https://www.anaconda.com/
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Figure 2: Python Installation Default Location 

3. Locate the Windows Environment Variables on the PC. In the System Variables section add the 
following Path directories:  

• C:\ProgramData\Anaconda2 

• C:\ProgramData\Anaconda2\Library\bin 

 IMPORTANT: Make sure these are added to System Variables and not User Variables. 

4. Open the Anaconda Prompt as administrator and run:  

conda install protobuf 

 

Figure 3: Install Protobuf 
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3 SightLine Sample Classifier Installation 

Download the Classifier Tools package from the custom classifier page on the SightLine website. 
Launch the installer and follow the installation prompts. After running the installer navigate to 
C:\SightLine Applications\SLA-Classifier-Tools <<version number>>\ClassifierTraining\ and extract 
caffe3_python.zip and TrainingImages32.zip. Extract the files to default locations as shown below. 

 

Figure 4: Extract Example Training Images and Caffe Tools 

3.1 Software Versions Prior to 3.4.x 

Prior to software version 3.4.x, this code was in the ARM Processor Code Examples package. After 
running the installer, the code was located at C:\SightLine Applications\SLA-Examples-ARM-<<version 
number>>\Classifier\. If using prior software, use this filepath to replace all instances of the filepath 
C:\SightLine Applications\SLA-Classifier-Tools <<version number>>\ClassifierTraining\. Then, the rest of 
the steps can be followed as noted above. 

 For SLA-Examples-ARM 3.02.00 the caffe zip file will be caffe.zip. 

 The files in TrainingImages64.zip are only needed when training a network with a different input 
image size. See Appendix B.  

 No additional steps are necessary to build and install Caffe. For additional information see the Caffe 
website and the Caffe tutorial. 

4 Custom Classifier Development 

The following sections describe how to build a custom classifier based on sample data in the 
C:\SightLine Applications\SLA-Classifier-Tools <<version number>>\ClassifierTraining\TrainingImages32 
directory.  

 This process assumes that the default Caffe installation provided in the installer is being used and 
has been built with CPU support only. For details on training with GPU support see Appendix A. 

Once the custom classifier is complete use a test pattern on the hardware to test it (see Testing - Multi 
Car Test Pattern). The diagram in Figure 5 outlines the steps in the sections that follow. 

https://sightlineapplications.com/custom-classifier/
https://caffe.berkeleyvision.org/installation.html
https://caffe.berkeleyvision.org/tutorial/
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 To run a sample classifier that is pre-trained skip to the Test Classifier section and use the 
sample_classifier_params.cls file located in C:\SightLine Applications\SLA-Classifier-Tools <<version 
number>>\ClassifierTraining\. 

 
Figure 5: Training Steps 

4.1 Generate Training Images 

The first step in building a classifier is to generate a large set of training images. In this example, the 
dataset contains the following three class types: background, people, and custom_0, where custom_0 
represents images of a synthetic car.  

 If using the example dataset skip to the Create Training Set section. 

To start training the data: 

1. Create a set of PNG greyscale images. See Appendix B for additional details on training different 
size patches. 

Training Images custom_0 

class_mapping.txt trainWin.txt, valWin.txt 

sl_train_Imdb, sl_val_Imdb 

mean.binaryproto 

quick_solver.prototxt 
sl_quick_train_test.prototxt 

quick_solver.prototxt 

sl_quick_*.caffemodel* 

classifier_params.cls 

Copy to HW to test 

testWin.txt 
valWin.tx 

Confusion matrix 

background people 

01_create_training_set 

02_create_sl_Imd
b 

03_create_mean_image 
  

04_train_model 

create_trained_model (run all) 

Testing the classifier 

05_create_classifier_model 
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2. Create folders based on the supported class types, e.g., background, airplane, boat. 

3. Organize and place the images in their respective folders. 

 It is helpful to have a class that includes negative examples. For this example, negative examples 
are any images that are not a synthetic car and are represented in the background directory. 

 

Figure 6: Example Training Images Directory Structure 

4. Additional changes to the create_training_set.py script may be needed depending on the naming 
scheme for class types, the number of class types (see Change Number of Outputs), and additional 
factors.  See below. 

4.2 Create Training Set 

The create_training_set.py file is a python script used to create the training, validation, and testing 
data set from the images described in the Generate Training Images section. It is also used to create 
the class mapping file as described in Create Custom Class Mapping section. 

The output of this script is a series of files that contains a list of filenames. The first 80% of the data is 
put in the trainWin.txt file. The next 15% is put in the valWin.txt file. The final 5% of data is put in the 
testWin.txt file. 

 

Figure 7: Modify Class Names - PiP Labels 

During the training process only the trainWin.txt and valWin.txt files are used. The testWin.txt file can 
be used for testing the classifier. 

 The folder names in the preDefinedTypes array must exactly match the folder names of the training 
data.  

 Even though the example shown in Figure 7 only shows three custom types, up to 100 custom types 
(number 100-199) can be added. 
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4.2.1 Modify Default Definitions 

The training process assumes that the directories provided are being used with the example and that 
the output will be placed in the .output directory. To configure these settings, edit the definitions near 
the bottom of the created_trained_model.py script.  

 Additional information on when to edit definitions can be found in the applicable sections of this 
EAN. 

 

Figure 8: Global Definitions 

4.2.2 Create Custom Class Mapping 

When the create_training_set.py script is running it is also responsible for generating a 
class_mapping.txt file. This file is used to describe the mapping of the classifier output type to the final 
SightLine reported types. 

The text in the preDefinedTypes array can also be edited to add a better descriptive name for the 
classified object to the class_mapping.txt file. This name will be used when viewing the class label in 
the PiP window (see the Picture-in-Picture (PiP) Label section). In the example shown in Figure 7 
Custom-0001d was changed to TestCar. 

 Names must be limited to 15 characters. 

4.2.3 Create Training Set Script 

Once modifications are complete run the following script from a command prompt or Windows 
PowerShell console: 

01_create_training_set.bat 

 

Figure 9: Example - Create Training Script 

 Verify that this step was successful by checking the trainWin.txt file as shown in Figure 10. This can 
be found in the .output directory. 
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Figure 10: Example trainWin.txt Data 

4.3 Generate LMDB Files 

The next step in training is to create Lighting Mapped Database (LMDB) files. Run the following script 
to generate the LMDB files: 

02_create_sl_lmdb.bat 

In this example no modifications are required to this script.  

The output of the script will describe what has been processed. An example of a portion of the output 
is shown in Figure 11. 

 

Figure 11: Example Output of LMDB Process 

Once the script is finished running, the folders shown in Figure 12 are generated. Each folder will 
contain the MDB files that contain a key-value database of image buffers for later use. 

 

Figure 12: Train and Validation Database Folders 

 Additional information on the Caffe tool convert_imageset can be found by looking at the Caffe 
Source. 

When running convert_imageset in the script, the –shuffle parameter has been removed. Removing 
this parameter allows the script to run multiple times with the same result. Add this parameter back in 
to run this process over and over with multiple initial datasets, and then choose the best result. 

 Since everything is treated as grayscale, the --gray=true parameter is used in this example.   

https://github.com/BVLC/caffe/blob/master/tools/convert_imageset.cpp
https://github.com/BVLC/caffe/blob/master/tools/convert_imageset.cpp
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Figure 13: Example Creating LMDB Files From create_trained_model.py 

4.4 Generate Mean Image Data 

The next step in building the trained model is to generate a mean image data file. To create this data 
run the following script: 

 03_create_mean_image.bat script. 

 The output of this process is the mean.binaryproto file that contains all the mean image data. 
Customizing this file is not necessary. 

4.5 Train the Classifier 

This step can take several hours or several days if CPU is used depending on the complexity of the 
network, the number of images, and other training parameters. For this example, expect two to four 
hours if the number of training iterations are not reduced, or one to two hours if they are reduced.  

 Before running 04_train_model.bat it is important to make the required file modifications.  

4.5.1 Change Number of Outputs 

Two files define the network structure used for both training and actual deployment of the network: 
sl_quick.prototxt and sl_quick_train_test.prototxt.  

In this example both files must be updated to set the number of outputs to 3 because there are only 
three class types: background, people, and custom_0.   

Modifications are made to the ip2 layer on both files as shown in Figure 14 and Figure 15.  The 
num_output value should be changed to match the number of class types created above in Generate 
Training Images. 
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Figure 14: File Update - sl_quick.prototxt 

 

 
Figure 15: File Update - sl_quick_train_test.prototxt 

4.5.2 Reduce Training Time (Optional) 

 Skip this section if GPU is being used for training. 

The default training time can be long. To help reduce training time, modify the following file that 
defines the parameters used in the training process: 

• quick_solver.prototxt - Change stepsize from 8000 to 4000  

• quick_solver.prototxt - Change max_iter from 11000 to 7000 

 
Figure 16: File Modification - quick_solver.prototxt  

4.5.3 Run Training 

After completing the changes to the network and training files, run the training by executing the 
following  script from either a command prompt or Windows PowerShell console: 

04_train_model.bat 
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4.6 Generate Binary File 

Once the training is complete, convert the data into a binary classifier file that the SightLine system can 
process.  

 Read this entire section before starting this process to ensure the necessary changes are made to 
the commands based on any modifications to the training process in the previous sections. 

To convert the data run the following script: 

05_create_classifier_model.bat  

When the script is complete it will generate a classifier_params.cls file. It is important to rename the 
file to avoid overwriting it next time you generate a binary file. For this example, the file has been 
renamed to custom.cls. 

4.7 Test Classifier with Caffe 

After training is complete, use the sl_test_model.py script to test the model on a series of images or on 
individual images as shown in Figure 17.   

This testing uses Caffe software. SightLine hardware uses an optimized version of Caffe, so the results 
are not guaranteed to be the same. 

python sl_test_model.py .output/testWin.txt –-image_root=TrainingImages32  

The output of this step is a confusion matrix and an accuracy score. The confusion matrix shows the 
predicted classes (rows) compared to the actual classes (columns).  

 

Figure 17: Caffe Classifier Test Example 

This process can also be used to test individual images: 

python sl_test_model.py TrainingImages32/custom_0/img_tp13_5604_288_1.png 

This example will show the predicted output class of the image. 

 New to 3.6, visualization tools are included in the SLA-Classifier-Tools to help with training analysis. 
See Appendix F for more details. 

4.8 One Step Training 

SightLine has created a create_trained_model.py script that runs all the steps in the Custom Classifier 
Development section. Before using this script, it is important to become familiar with all the steps in 
this section to make sure any additional changes that need to be made can be completed at this time. 

The following is an example of using this script to complete the entire process:  

python create_trained_model.py 
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The Batch Training Tools directory in the SLA-Classifier-Tools folder includes batch scripts to make it 
easier to run the steps in the Custom Classifier Development section multiple times. These scripts call 
each of the steps for a specified number of iterations. For more user information see Appendix E. 

5 Test Classifier on Hardware 

The following sections describe the steps required to test the custom classifier created in Custom 
Classifier Development section based on the SightLine example training images. These same steps will 
be useful in understanding how to upload and test any custom classifier.  

 This section assumes connection to the 4000-OEM with Panel Plus. The same steps are valid for the 
3000-OEM.  

5.1 Copy Binary File 

To copy the file, use the SLA-4000 Upgrade Utility. See the EAN-Firmware Upgrade Utility for more 
information on using this application. 

 

Figure 18: SLA-4000 Upgrade Utility 

5.2 Testing - Multi Car Test Pattern 

To use the Multi Car test pattern in Panel Plus to test the classifier: 

1. From the main menu in Panel Plus go to Configure » Acquisition Settings.  

2. Set up one of the cameras to be a multi car test pattern.  

 

Figure 19: Multi Car Test Pattern 

3. Click Apply. 

4. Main menu » Parameters » Save to Board. 

5. Main menu » Reset » Board. 

6. Wait for the system to boot, and then reconnect to the board.  

http://sightlineapplications.com/wp-content/uploads/EAN-Firmware-Upgrade-Utility.pdf


 EAN-Classifier-Development  

© SightLine Applications, Inc.                                                                                                                                                    14

                                                                                                                                                          

5.3 Verify Telemetry 

The following sections discuss the different methods to look at classifier related telemetry. These 
commands are all based on the commanded camera.  

 Ensure the commanded camera in Panel Plus matches the camera setup as the Multi Car test 
pattern. In the example shown in Figure 19 it is Cam 1. 

5.3.1 Enable Vehicle Detection 

1. From the Track tab in Panel 
Plus click on the Detect tab.  

2. From the Mode drop-down 
menu select Vehicle to 
enable the vehicle detection 
mode.  

 

Figure 20: Enable Vehicle Detection 

5.3.2 Enable Classification of Vehicle Detections 

1. From the Track tab in Panel 
Plus click on the Classifier 
tab.  

2. In the Vehicle, Drone, Person 
drop-down menu select All 
Tracks - Including 
Vehicle/Person/Drone Detect 
Tracks to enable this 
classification.  

 

Figure 21: Enable Classifier 

5.3.3 Update the Custom Classifier 

To use a different classifier on the OEM, update the binary classifier file name.  

1. From the Track tab in Panel Plus click on the Classifier tab.  

2. Click Request Files to refresh the file names in the Custom Classifier File Name field. 

3. Choose your custom classifier. 
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4. Click Update File. The new classifier parameters will update prior to the next call to the classifier.  

When updating files look for any user warnings for potential issues. 

 

 Figure 22: Custom Classifier File Name 

5.3.4 Telemetry Dialog 

1. Make sure that the classifier is enabled as shown in Figure 21.  

2. To show the telemetry dialog, click the Show Telemetry button on the bottom of the Track tab or 
go to the Panel Plus main menu » View » Telemetry.  

3. In the Telemetry dialog window select the Send Telemetry 2Me check box and the Extended check 
box (Figure 23).  

 When a track is created telemetry is shown in their respective sections. Class type (ClassID), and 
confidence in this type (ClassConf) are shown in the Extended section. 

 If the ClassID shows that it unclassified make sure that the classifier is enabled as shown in Figure 
21. 

 

Figure 23: Telemetry Dialog Window 
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5.3.5 Picture-in-Picture (PiP) Label 

To view the classification of the tracks in a detection mode go to the Display tab. Verify the following: 

✓ The Video Source is set to Multi. 

✓ Select Zoom on All Tracks. 

✓ The PiP Label is set to Classification. 

✓ The Main index and PiP index are both set to the active camera. 

 

 Figure 24: Multi Camera Setup 

The class names labels created in Create Custom Class Mapping will be used as the PiP labels shown in 
Figure 25. 

New in 3.5.x software. The Track Index + Class  PiP label option for classification shows the track index 
and classification name in the PiP window at the same time. 

 

Figure 25: PiPs Display - Custom Classifier Labels 
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6 Troubleshooting 

Question  Answer 

Can more images be added to the training 
set? 

 Adding more images for different classes can improve the performance of 
the classifier. It is important to consider what types of images are being 
used. A variety of images is necessary, otherwise overfitting can occur, and 
classifier performance will decline. It is also important to consider whether 
a balanced dataset is necessary. This requires a deeper understanding of 
the issues involved and cannot be answered generically for all use cases. 

Can color be used in the training?  Color is not supported at this time but may be added in future updates. 

Can a system with 1000 classes be 
trained? 

 SightLine supports up to 100 custom classes and 100 SLA predefined 
classes. For more information about specific use cases, contact Sales for 
recommendations. 

It is also important to understand that the SightLine network deployed for 
drone detection is streamlined to run at frame rate on an embedded 
device. A much larger network may be required for other problems and 
may not be able to run fast enough on SightLine hardware.  

Is GPU training supported?  Yes. GPU training is supported for some NVIDIA GPUs. See Appendix A for 
more information. When training with a GPU that is not supported, Caffe 
can be built directly and used in place of the SightLine provided version. 

In Drone mode, classification can be used 
to filter out false positives. Is this also 
possible when developing a custom 
classifier?  

 As of 3.4, SightLine offers classification filtering for all detection 
algorithms when using the custom classifier. These filters can be set up 
using the ClassifierParameters (0xA9) message. See the IDD for more 
details. 

 

Can a more complicated model structure 
be used on the 3000-OEM or 4000-OEM? 

 Yes, alternate model structures are supported, but there are limitations. 
See Appendix C for more details. 

Does SightLine provide tools for extracting 
images for training? 

 Yes, using the Detection to Snapshot feature many images can quickly be 
generated for training. See Appendix D for more details. 

Does SightLine provide tools for visualizing 
data from training? 

 Yes, 3.6.x software includes Classifier Tools to visualize certain metrics. See 
Appendix F for more details. 

On the 1700-OEM, why are my binary 
classifiers not achieving the faster 
execution time running on the NPU? 

 With the 3.6.x software release, there is a known issue that binary 
classifiers (classifiers with two classes) will not run on the NPU due to an 
internal issue with the library. SightLine is working to resolve this issue. In 
the interim, binary classifiers will not run on the NPU, but all other classifier 
types will. Therefore, binary classifiers will not achieve the faster runtime. 

6.1 Questions and Additional Support 

For questions and additional support, please contact SightLine Support. Additional support 
documentation and Engineering Application Notes (EANs) can be found on the Documentation page of 
the SightLine Applications website.  

mailto:sales@sightlineapplications.com
https://sightlineapplications.com/releases/IDD/current/struct_s_l_a_classifier_parameters__t.html
https://sightlineapplications.com/releases/IDD/current/
mailto:support@sightlineapplications.com
https://sightlineapplications.com/documentation/
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Appendix A - Caffe GPU Support 

An NVIDIA GPU can be used to accelerate the training process. These instructions assume familiarity 
with the training process using the CPU version and a compatible NVIDIA GPU.  

1. Determine the version of CUDA support: 

a. Open a command prompt and run nvcc -V. 

 If nvcc does not exist, the CUDA Tool Kit may need to be installed. See the NVIDIA Developer 
website to download the CUDA Toolkit. 

 Make sure the downloaded CUDA Toolkit matches one of the versions supported in Step 2. If it 
does not, reinstall a version of the CUDA Toolkit that matches one of the versions below (this 
may not be the latest version). 

b. Record the release version located after Cuda compilation tools, release.  

 

2. Download the compatible Caffe build based on the version of CUDA identified in step 1 from the 
following list of links:  

• Version 3.3.x 

CUDA 8.0 Python3 CUDA 9.2 Python3 CUDA 10.2 Python3 

• Version 3.2.x 

CUDA 7.5 CUDA 8.0 CUDA 9.2 CUDA 10.2 

3. Copy the file to the C:\SightLine Applications\SLA-Classifier-Tools <<version 
number>>\ClassifierTraining\. 

4. Extract the file using 7zip. 

 

5. Edit the create_trained_model.py script to set CAFFE_GPU to point to the new directory. 

 

 Do not change 
CAFFE_ROOT 
Change CAFFE_GPU to 
the new directory. 

https://developer.nvidia.com/cuda-toolkit-archive
https://sightlineapplications.com/classifier-downloads/Release_CUDA_8_0_Python3.7z
https://sightlineapplications.com/classifier-downloads/Release_CUDA_9_2_Python3.7z
https://sightlineapplications.com/classifier-downloads/Release_CUDA_10_2_Python3.7z
https://sightlineapplications.com/classifier-downloads/Release_CUDA_7_5.7z
https://sightlineapplications.com/classifier-downloads/Release_CUDA_8_0.7z
https://sightlineapplications.com/classifier-downloads/Release_CUDA_9_2.7z
https://sightlineapplications.com/classifier-downloads/Release_CUDA_10_2.7z
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6. Train the network by running the following script: 

04_train_model.bat 

 When GPU is used for training, the created models are slightly different each time it is created. This 
is due to a non-deterministic nature of CUDA implementation. 

 This build of Caffe does not support multiple GPUs. If using a system with multiple GPUs, make sure 
to specify a GPU on the system to enable the scripts to run. This can be done by editing the 
create_trained_model.py script and setting the value in “-gpu all” to “-gpu 0”  or  “-gpu 
1”. 

 

Figure A1: Specifying a GPU 

Appendix B - Train Different Size Patches 

32x32 training images are used in the training process described in Custom Classifier Development 
section. To train a network with a different size use the following modifications.  

 A set of 64x64 images included in the TrainingImages64.zip file can also be used for training. 

1. In the create_trained_model.py file the directory name and image size needs to be changed as 
follows: 

 

2. In the sl_quick.prototxt file update the dim parameter near the top of the file to the correct size.  

input_param { shape: { dim: 1 dim: 1 dim: 64 dim: 64 } } 

 Using a larger model will result in slower performance when running the classification on the 
hardware. Running a 32x32 classification on the 4000-OEM takes about 1.1 msec and running a 
64x64 classification takes about 4.2 msec.  

if len(CAFFE_GPU) > 0: 

 caffePath = sl_util.add_slash_at_at_the_end(CAFFE_GPU) 

 gpu = “-gpu 0”    

if len(CAFFE_GPU) > 0: 

 caffePath = sl_util.add_slash_at_at_the_end(CAFFE_GPU) 

 gpu = “-gpu all”    

 

 Change to 
TrainingImage64  
Change 32 to 64 
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Appendix C - Alternate Model Structure  

The model structure used in training is defined in sl_quick_train_test.prototxt. The model structure 
used for deployment (also called inference) is defined in sl_quick.prototxt. SightLine recommends 
starting with this model structure for training and deployment.  

 SightLine supports different model structures with some limitations. Contact us for more 
information.  

The complexity of the model structure impacts runtime. Before investing a lot of time in training a 
complicated model, verify that it will run on the 3000-OEM or 4000-OEM without impacting frame 
rates.  

 The Performance graphs in Panel Plus shows the time used by the processing steps. From the main 
menu go to View » Show Performance Graphs (see EAN-Performance-and-Latency). 

C1 Supported Deployed Network Layers 

There are a limited set of layers that are supported for the deployed network (sl_quick.prototxt). If a 
binary file is loaded that includes layers that are not supported a user warning will be displayed. 
SightLine supports the following layers: 

• Convolution 

• Pooling 

• Activation (ReLU, Sigmoid, TanH) 

• Batch Normalization 

• Inner Product 

• Softmax 

 Contact Technical Support for any additional layers that may be needed not shown in this list. 

During training, any layer that Caffe supports can be used. However, it is important that the training 
network correctly trains for the final deployed network. For example, dropout is a layer type used in 
sl_quick_train_test.prototxt. This is a normal training layer that is not used in the deployed network, 
which is acceptable. If a threshold layer is added to the training, that same layer may be needed in the 
deployed network, which is not currently a supported layer. 

 

 

 

 

 

 

mailto:support@sightlineapplications.com
http://sightlineapplications.com/wp-content/uploads/EAN-Performance-and-Latency.pdf
mailto:support@sightlineapplications.com
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Appendix D - Create Training Images 

Extracting images patches can be a very time-consuming part of the classifier training process. The 
snapshot detection feature described in the Detection Snapshots section of the EAN-File-Recording 
document can streamline this process. This feature can be used when streaming live video or on 
previously recorded video (see EAN-Decoder).  

 Detection Snapshots require the Recording app bit.  

Snapshot detection setting notes: 

• Snapshot Size Type:  Auto. This will result in the actual detection being scaled to the setting in 
Snapshot Size.  

• Max Snapshots Per Frame:  1 to 3 depending on the storage media. 

▪ Use 1 for microSD cards. 

▪ Use up to 3 for an SSD USB drive.  

• Min Frames Between Snapshots: ~30 

For example, there are 30 detections in every frame. Max Snapshots Per Frame is set to 1 and Min 
Frames Between Snapshots is set to 30. This means there will be one snapshot of each detection 
every second. After 10 minutes there will be over 10,000 snapshots.  

 Detection snapshots are not labeled and must be manually sorted prior to training.  

 If training a classifier for a specific detection algorithm, use that detection algorithm to gather 
snapshots so that the training data is a good representation of the real data. 

Appendix E - Batch Training Tools 

Classifier performance is susceptible to randomness that can be caused by the GPU and which images 
are selected for the train/test/validate image sets during training. For this reason, it is important to run 
the classifier training steps multiple times, and then select the classifier with the best performance. To 
make this process easier the Batch Training Tools directory in the SLA-Classifier-Tools folder includes 
the following batch scripts: 

• train_n_times_inner.bat: Loops scripts 4-5 a set number of times, input as a command line 
argument (default is 1). This results in the creation of multiple models from the same image set. 
This is desirable when training on a GPU, which produces different results in training even with the 
same parameters and input data. This batch file gets called by train_n_times_outer.bat.  

 If running on a CPU, the results from multiple iterations of train_n_times_inner.bat will always be 
the same. This is because training on a CPU, unlike a GPU, is deterministic for the same input image 
set and model parameters. 

• train_n_times_outer.bat: Loops the scripts 1-5 a specified number of times (default is 1). Set this 
number as a command line argument, and the number of times to loop scripts 4 and 5 as the 
second command line argument. The second argument gets passed into train_n_times_inner.bat.  

http://sightlineapplications.com/wp-content/uploads/EAN-File-Recording.pdf
https://sightlineapplications.com/wp-content/uploads/EAN-Decoder.pdf
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 Only the train_n_times_outer.bat needs to be run since it takes in command line arguments for 
both scripts as follows: 

.\train_n_times_outer.bat <outer loop iterations> <inner loop iterations> 

The batch scripts output files for each training run in a folder automatically created for that outer loop 
iteration. For example, if the number of outer loop iterations is set to three, the following folders will 
be created in the parent directory of the classifier training folder: 

• 1_train_batch_files 

• 2_train_batch_files 

• 3_train_batch_files 

The following files are included in each folder:  

• caffemodel.h5 

• .cls 

• mean.binaryproto 

• Text files indicating testing, training, and image validation sets.  

A caffemodel.h5 and a .cls file get generated for each script 4-5 iteration. Each folder can contain as 
many caffemodel.h5 and a .cls files as the inner loop iterations.    

 IMPORTANT: Since all folders and files are overwritten each time the batch script runs, be sure to 
copy folders to a different location before running the batch script again.  

E1 Testing the Classifier 

After running the batch scripts test the classifier using one the following methods: 

• Use the SightLine provided test scripts on your own designated test set. 

• Load the model directly on the OEM board to run on video in Panel Plus. 

To use the test scripts or Panel Plus to test the classifier, see the sections on Test Classifier with Caffe 
and Test Classifier on Hardware.   

It is important to replace the example names in the above sections with the names generated by the 
test script. For example, instead of inputting custom.cls as described in Figure 22 in the Update the 
Custom Classifier section, put the name of the .cls file generated as part of the custom classifier 
creation.  

Appendix F - Training Visualization Tools 

To help with training analysis while building models the SLA-Classifier-Tools directory includes a 
06_plot_training_data.bat script to organize the console output and plot the learning curve during the 
training phase. 

 IMPORTANT: This script must be run after running the 04_train_model.bat script. 
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Once the 06 and 04 training scripts have been run the following files are generated: 

• training_data.log: A log of the console output after running the 04_train_model.bat script. 

• training_data.log.train: The console output organized in a comma separated format that outputs 
the following data from training: 

▪ Num of iterations: Epoch count training is on. This means that after this many iterations, the 
time, learning rate, and loss are as shown on that line. 

▪ Time (in seconds): Number of seconds that has passed since training began. 

▪ Learning rate: The value of the learning rate at that iteration. If a fixed learning rate is used this 
value will not change. 

▪ Loss: The calculated loss in the softmax layer. 

• training_data.log.test: The console output organized in a comma separated format that outputs 
the following from training: 

▪ Num of iterations: Epoch count training is on. This means that after this many iterations, the 
time, learning rate, and loss are as shown on that line. 

▪ Time (in seconds): Number of seconds that has passed since training began. 

▪ Learning rate: The value of the learning rate at that iteration. If a fixed learning rate is used this 
value will not change. 

▪ Accuracy: Accuracy of the model on the test set at that layer. 

▪ Loss: The calculated loss in the softmax layer. 

• training_plot.png: This file is generated from the values in the train and test files. It shows a plot 
with the number of Iterations on the X axis, Loss on the Y1 axis, and Accuracy on the Y2 axis. An 
example is shown in Figure F1. 

 

Figure F1: Training Plot Example 
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